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INSTALLING 
COLORANT

Getting Started 
with ColorAnt 3.0
Installation, requesting demo licenses, 
loading licenses and permanent licenses
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Installing
ColorAnt 3 
System requirements
Mac OSX 
10.5 or later - (Intel only)
Windows
Windows XP, Vista, Windows 7, 
Windows 8 
Installers for the respective plat-
form installs the program by default 
in either the Applications folder 
(Macintosh) or the Programs folder 
(Windows). Begin installation by 
double-clicking on the ColorAnt 
installation package.
After accepting the Software License 
Agreement, select the destination 
volume and choose between a 
Standard Installation or custom 
installation. Standard Installation 
installs all components, custom in-
stallation includes the UPPCT tool as 
described below.

UPPCT – ColorAnt contains the 
option of directly measuring test 
charts for profile creation, rather 
than measuring and saving them 
exclusively via external measuring 
software and then importing them 
into ColorAnt.

Computer vs USB 
dongle license
Computer-based ColorAnt licens-
es always refers to a the specific 
computer on which ColorAnt was 
installed and can be requested for 
temporary test purposes. Computer 
licenses are also advantageous if the 
computer has no USB ports or no 
space for a USB dongle, i.e. a rack 
server.
USB dongle licenses are serialized 
to the ColorAnt USB dongle. The 
ColorAnt USB dongle is shipped with 
the permanent license of ColorAnt 
and permits use of ColorAnt on 
different computers. To be able to 
assign the license to the USB don-
gle, the dongle must be connected 
before starting ColorAnt.

Demo license request
ColorAnt allows users to automati-
cally request a   14 day demo license 
to evaluate ColorAnt.
To request a demo license follow 
the steps below:

1. Click the registration button 
located on the lower left-hand corner 
of the Main Navigation Panel.
2. Click on the Demo license 
request tab. 

01 INSTALL
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3. Enter all required information. 
4. When your location is chosen, 
ColorAnt will show the available deal-
ers for your region. Select a dealer and 
click send direct request. A demo li-
cense will be automatically sent to the 
email address supplied in the contact 
form.
5. Save the license file contained in 
the email (indicated by the ending *.lic) 
to your system. 
6. Under License details in the 
Registration window and select the 
.lic file.
After install-
ing the demo 
license file, the 
expiration date 
of the demo 
license is shown 
below the 
License details 
(Fig 1.1).

Restrictions with Demo 
licenses and ColorAnt
ColorAnt demo license gives users 
a 14 day evaluation period to try all 
the functions of ColorAnt within the 
application. The demo license permits 
saving and exporting of data.

Purchasing ColorAnt
ColorAnt is available in 2 packages, M 
or L. Click on Buy ColorLogic prod-
ucts under License details or Demo 
license request in the Registration 
window.

A list of ColorLogic resellers will 
open in your browser, then locate the 
appropriate dealer for your country or 
region. 

Installing a permanent 
license 
A permanent license provided by the 
individual dealer will be supplied after 
purchasing ColorAnt. The permanent 
license is available in the form of a 
computer-based license or a dongle 
license (see previous section).
After purchasing the software, a 
permanent license file (.lic) will be 

sent via email 
license. Load 
the license file 
under License 
details in the 
Registration 
window.
After installing 
the permanent 

license file, the licensed modules are 
displayed under the License details.

License status information
FIG 1.1
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ColorAnt 3 PACKAGES

› ColorAnt 3 Packages and Add-Ons
ColorAnt 3 packages include more standard features.

ColorAnt Documentation
ColorLogic's ColorAnt offers some of the most intelligent and advanced 
measurement data tools in the industry today. Integrated within ColorAnt 
are help buttons represented with the ? icon, with detailed and current 
information.

Automatic Updates
ColorAnt includes an automatic update function that can be enabled or 
disabled by going to Help>Check for Update.

COLORANT M COLORANT L

STANDARD FEATURES
All Features 

of ColorAnt M

Custom Chart Generation
Colorspaces: Gray, RGB and CMYK

Edit Primaries Multicolor
 CMYK and Multicolor

Edit Primaries
Edit Primaries for CMYK Multicolor Custom Chart Generation

Enhanced Analytical Tools

CIE Conversion
Edit the Standard Observer
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MAIN
PANEL

ColorAnt's Main 
Navigation Panel
Access all of ColorAnt 3 functions from 
one centralized location.



10 MAIN PANEL

02 MAIN
PANEL

Auto

RescaleTone ValueBrightener

Custom
Chart

MeasureExport
Chart

Report

Edit 
Primaries

Registration Preferences

Automatic Correction

Editing

Merging and Conversion

Data Import/Export

Averaging Link ICC
Transformation

CIE
Conversion

ICC

Redundancies Correction Smoothing White
Correction



MAIN PANEL

The ColorAnt 3 Interface
ColorAnt 3's main panel interface allows quick access to all tools from one easy-
to-use location. Icons display the purpose of each function on the panel. 

Automatic
Correct measurement data 
automatically

Custom Chart
Create custom charts for 
measurement

Export Chart
Export custom chart for printing

Measure
Measure printed charts with the 
UPPCT tool

Report
Generate detailed reports on 
measurement data

Redundancies
Correct redundant patches by 
averaging data

Correction
Corrects and detects faulty mea-
surements and inconsistent data

Smoothing
Smooth and correct uneven 
curves

White Correction
Apply manual correction to the 
most white area

Optical Brightener
Remove optical brightener from 
measurement data

Tone Value
Correct measurements as if 
they were printed to a specific 
reference

Rescale
Recalculate data to a different 
color chart

Edit Primaries
Add, remove, and exchange 
primaries or the paper/substrate 
into an existing measured test 
chart

Average
Average several data sets into 
one data set

Link
Combine multiple charts into 
one measurement file

ICC Transformation
Use ICC device and DeviceLink 
profiles to test impact on data

CIE Conversion
Change the standard observer 
illumination from standard D50

11

Registration
Access the Registration and 
license dialog
Preferences
Preferences - Report 
customization, default units, 
Display Density, Tone Value 
Calculation 

Online Help 
Online help is available 
through clicking any of the 
? located on any of the 
application windows. 

?
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Data Sets and History
The Data Sets section of the main window will display pertinent informa-
tion about the measurement data including: number of color patches, color 
model (Lab, CMYK, RGB, Multicolor), measurement value type (colorimet-
ric = Lab - spectral = Remission)

History
The tools applied to the measurement data show in the lower right hand 
side History window. Clicking on an action item in the History window 
(either above or below the current status) gives the user control over 
individual corrective tasks.

MAIN PANEL
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Viewing and 
Comparing Options
Advanced viewing options 
for ColorAnt 3 include tools 
located at the bottom of 
the main window which can 
be enabled for both viewing 
measurement data (View) 
and comparing pre and post 
comparison of measurement 
data (Compare).

2D highlight with 
the Color Filter
The Color Filter highlights 
selected colors in 2D and 3D 
views. View by full primaries, 
limits, primaries, secondaries, 
paper white or black. Duplex 
and Triplex options are also 
available.

3D viewing options
The Color Filter highlights 
selected colors in 3D views. 
Zoom and rotate the model 
by using the sliders. The same 
filter options are available in 
the 2D view.

MAIN PANEL
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Curves
View the linearity curves from white 
to all 100% primary colors, (including 
multicolor data) Visualizes data and 
assists with analyzing non-smooth 
gradation curves.

TVI View options
Analyze tone value variation 
curves (TVI). The tone value 
curve works in conjunction with 
the curve view or any other cor-
rection which will effect the TVI.

Spiderweb
The top view of the color 
space in a a*-b* diagram. The 
measured or optimized color 
patches are arranged in a spi-
der web configuration. Verify 
changes in the View dialog by 
moving forward or backward 
in the History list.

MAIN PANEL
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USING
COLORANT

Automatic Correction
Correct and optimize measurement 
data with one click

View
View measurement data with 2d, 
3d, spider web and curves

Compare
Compare measurement data 
before and after correction
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Working with ColorAnt
ColorAnt 3’s main window is 
divided into 3 sections. All tools are 
located and grouped by function 
on the left hand side, measurement 
data is shown in the Data Set 
section on the right hand side upper 
window of the application window. 
Measurement data can be loaded or 
saved via the File menu or by drag-
ging & dropping 
data to the Data 
Set window. Tools 
applied to the 
measurement data 
show are shown 
in the lower right 
hand side History window. Clicking 
on an action item in the History 
window (either above or below the 
current status) gives the user control 
over individual corrective tasks.

Automatically 
correcting and 
smoothing 
measurement files
Load the measurement data file as 
describe previously. Click on the 
Auto button and on the OK button. 
Each tool that is applied is displayed 
in the History section. ColorLogic 
recommends completing this pro-

cess running a Report for detailed 
results and further recommenda-
tions for your measurement data.

Recommended manual 
working method
Opening or Importing data

Measurement data can be loaded or 
imported through a variety of ways 
in ColorAnt. Simply open the data 

file (File>Open) 
or Drag and 
Drop to the 
Data Sets win-
dow. Predefined 
data sets and 
recently opened 

files are also available via the File 
menu. 
Acquiring data through 
measuring

Measurement data acquired 
with the UPPCT tool (reference 
page) is transmitted to ColorAnt. 
Measurement data files created by 
the UPPCT Measure tool are stored 
in the Users/Documents/ColorAnt/
MeasurementData folder.
The Data Sets section of the main 
window will display pertinent 
information about the measurement 
data including: number of color 
patches, color model (Lab, CMYK, 

03 USING
COLORANT

Using Auto is the quickest 
method to get instant high 
quality results.
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USING
COLORANT

RGB, Multicolor), measurement value 
type (colorimetric = Lab - spectral = 
Remission).
Tools located on the left will be 
highlighted when applicable to 
the measurement data, tools not 
accessible are grayed out. Access the 
tools quickly by first highlighting the 
data (or multiple files e.g. linking or 

merging several data sets together) 
and right clicking. When multiple 
data sets are present and no set is 
selected, corrections are applied to 
all measurement files.
To add reference files for other pro-
filing test charts and color wedges to 
be able to access using the File/Open 
predefined dialog or via the Rescale 

tool - add the CGATS 1.7 compat-
ible TXT file to Users/Documents/
ColorAnt/Wedges folder. 

Viewing and Comparing 
Data
Advanced viewing options for 
ColorAnt 3 include tools located at 
the bottom of the main window can 

be enabled for both viewing mea-
surement data (View) and comparing 
the original and post comparison of 
measurement data (Compare).

The View window includes options 
for 2D, 3D, Spider Web and TVI 
curve options to facilitate compre-
hensive measurement data analysis. 

Main window with Data Sets section
FIG 3.1
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Color Comparison allows the user to 
view measurement data before and 
after optimization. The comparison 
window also allows the user to view 
the actions taken to achieve the opti-
mized data (eg File Name Correction, 
File Name Smoothing). The Mark 

from and Mark to slider displays vari-
ous levels of DeltaE deviations.

Saving or exporting 
measurement data
Once a tool or tools have been used 
to correct or optimize data, the 
name of the data will be append-
ed with the tool(s) that have been 
applied.

Save the optimized measurement 
data by going to File and choose 
Save as. Additional export options 
allowing conversion of spectral data 
to Lab or Density only. Other save as 
options include CGATS compatible 
TXT file, Named Color ICC profile, 

CxF3 compatible CXF file format, 
Photoshop ACO color table or as 
GMG CSC file.

Reporting
ColorLogic recommends using the 
Report tool both on the initial data 
import and after the measurement 
data has been corrected/optimized.

Compare data before and after correction
FIG 6.1
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DATA 
IMPORT & 
EXPORT

Create Custom Chart
Generate custom patches 
for test charts

Exporting Charts
Create custom size charts for various 
measurement instruments

Report
Create detailed reports from 
measurement data

Measure
Measure test charts with UPPCT
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Custom Chart
The Custom Chart tool is designed 
for creating the reference files for 
test chart generation. To define a 
custom test chart for profiling, a 
reference file containing 
the device data for the 
color space is required. 
Important: Creating 
multicolor charts 
requires a ColorAnt L 
license.
Depending on the 
selection of color space, 
the Custom Chart 
dialog provides several 
options:
Gray, RGB and 
CMYK: Define the 
Number of Patches and 
click OK. Select the de-
sired Color Space from 
the chooser.
CMYK: Choose the lin-
earisation from another 
measurement data set 
or from another print 
run as a starting point. To use the 
linearisation feature, load the appro-
priate measurement file in ColorAnt 
before opening the Custom Chart 
tool and select the file in the Color 
Space chooser.

Multicolor Charts

Several options are available:

Select the desired Color Space, for 
example to create a 6 color pro-
filing chart, ColorAnt will display a 

predefined color order, in this case: 
CMYK+Pantone Red and Green. 
The Eyedropper function allows 
reordering the inks. To exchange 
the 5 channel which is Red with 
Green, similar to fig 4.1 click on 
the Red Eyedropper Icon and from 

04 DATA IMPORT 
& EXPORT

Custom Chart Dialog
FIG 4.1
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the Colors section select Green by 
clicking on it.
Changing or defining the channel 
names

To change the channel names, click 
the Pencil icon, for example, click the 
green channel and type in the new 
name as shown in fig 4.1.
Define the chan-
nel name of each 
channel, (including 
or excluding CMYK) 
enter the name in 
the text field or 
click on the eye-
dropper icon and 
select a color from 
the pop up dialog 
that matches the 
inks the closest.
Select a linearisa-
tion from another 
selected measure-
ment file from the 
Color Space choos-
er. The Custom 
Chart tool will use 
measurement data 
to define names of the channels and 
will linearize the primaries. With 
this option, channel names are not 
editable.
Note: This option is useful with 
difficult print processes that are 
challenging to profile without lin-
earisation or having very high dot 
gain. ColorAnt uses a very smooth 
linearisation to avoid inconsistencies 
in the curves.
Once the color space, channel names 

and the Number of Patches are 
defined, click OK and calculate the 
reference file. The reference file will 
appear in the Data Sets section. Save 
the file if necessary for other chart 
generation tools. To create a test 
chart within ColorAnt, select the 
reference file and click Export Chart.

Export Chart
Export Chart allows creation of test 
charts as TIFF or PSD files to be 
printed. 
Define specific values required for 
specific measuring instrument, or 
start with a preset. Specify patch 
sizes (Patch width and Patch height) 
that can be defined either in millime-
ters or inches (Unit chooser in the 
Preferences pane) patch delimiter 
and patch distribution can all be cus-

Editing primary color names
FIG 4.2
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tomized. Consult the documentation 
for your specific device. The Custom 
Chart tool fills the full chart width 
with patches minus margins for the 
numbering. Instruments that do not 
have a width limitation (no ruler re-
quired) can benefit from this feature.

The Ink Limit option allows the user 
to take into account special printing 
processes that can't handle 400% ink 
on paper/substrate. Typically each 
of ColorLogic’s CMYK and multicol-
or test charts have patches with a 
maximum of 400% ink. If a 400% ink 

limit is too high for the press, or the 
user would like to define another ink 
limit, the user can enter the desired 
Ink Limit. The resulting chart will have 
ink limit integrated. Use the export-
ed reference file for measuring and 
profiling. 

Quick Start Procedure 
Step one: Select the reference file 
that was created with the Custom 
Chart tool or a reference file from 
another source.

DATA IMPORT/EXPORT

Export Chart
FIG 4.3
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Step two: Choose either one of the 
presets, or define a custom size and 
patch width.
Step three: Define the number of 
patches to be produced.

Measure test charts 
with UPPCT
The ColorAnt Measure tool has 
the option of directly measuring 

test charts for profile creation via 
the UPPCT software tool (Fig. 4.4)
from Swiss Center of Competence 
for Media and Printing Technology 
-  Ugra, rather than measuring and 
saving data via an external measuring 
software and then importing the data 
into ColorAnt. 

Productivity Feature:

When measurement data is load-
ed into the Data Sets window and 
Measure is selected, the previous 
chart and measurement device by 
default are automatically loaded into 
the UPPCT tool.

Quick Start Procedure
To access the UPPCT tool:

Step one: From the ColorAnt 
Data Import/Export module, click 
Measure. ColorAnt will confirm 
launching UPPCT, click OK and 
launch UPPCT.
Step two: Choose the measur-
ing chart from the Wedge Types 

UPPCT dialog box
FIG 4.4

DATA IMPORT/EXPORT
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dialog. For custom charts including 
ColorLogic's test charts, click Others 
and the select the desired chart from 
the pull down menu.
3. Select the measurement device 
under Measurement Instrument. and 
select the measuring 
mode (M1, M0 or M2). 
applicable for device or 
task. 
4. Select the method 
of scanning: by rows, 
by columns, single 
patches by line or 
column. 
5. Begin measuring: 
As you begin measur-
ing with the options 
chosen, grayed out 
patches are replaced 
by measurement data. 
Continue measuring 
until completed.
4. When measuring 
is completed, press 
Transmit to copy the 
data into ColorAnt.

Reporting
ColorAnt offers 
detailed reporting for 
measurement data 
analysis and pro-
vides the user with 
corrective recommendations for mea-
surement data. Users can customize 
the logo and report title (as shown). 
Reports can be generated as pdf files 
or .xml data.

Features of ColorAnt's Report tool 
include Tone Value increase chart and 
the option of utilizing a layered PDF to 
view combinations of channels. 
ColorAnt will report the presence of 
optical brightener the deltaE variance 

and the corrective action needed to 
improve the measurement data.
Other features of ColorAnt's are avail-
able via ColorLogic's online help.

24 DATA IMPORT/EXPORT

ColorAnt Data Report Page 2

Brightener
Brightener detected based on spectral analysis. Brightener correction would change paper white by dE76 1.01

Sample Colors
CMYK Lab dE¹ dE²

White 0 / 0 / 0 / 0 94 / -0 / -1 1.3 0.0
Cyan 100 / 0 / 0 / 0 43 / -20 / -50 20.4 0.0
Magenta 0 / 100 / 0 / 0 46 / 63 / 14 20.4 0.0
Yellow 0 / 0 / 100 / 0 87 / -5 / 86 7.4 0.0
Red 0 / 100 / 100 / 0 46 / 55 / 34 19.3 0.0
Green 100 / 0 / 100 / 0 40 / -38 / -11 47.6 0.0
Blue 100 / 100 / 0 / 0 28 / 4 / -29 25.5 0.0
Black 0 / 0 / 0 / 100 20 / 0 / -3 5.2 0.0
CMY Black 100 / 100 / 100 / 0 21 / -1 / -5 5.0 0.0
400% Black 100 / 100 / 100 / 100 12 / -0 / -2 5.3 0.0

(1) Coated FOGRA39 (ISO 12647-2:2004)
(2) Digital printer sample for profiling_Default.icc

3. Tone Value Increase Curves
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Digital printer sample for profiling.txt

ColorAnt report sample page
FIG 6.1
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EDITING
TOOLS

Redundancies
Remove redundant patches

Brightener
Correct for Optical Brighteners

Correction
Detect bad and correct data

Tone Value
Correct data to a specific print 
condition

Smoothing
Smooth the characteristics 
of measurement data

Averaging
Average multiple data sets 
into one data set

Rescale
Recalculate data to a different 
color chart

Link
Combine separately 
measured charts

White Correction
Correct paper white

ICC Transformation
Convert device data 
with ICC profiles

Edit Primaries
Change primary colors and 
recalculate measurement data

CIE Conversions
Convert measurement data to a 
different viewing condition
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Redundancies
Corrects color patches by 
averaging the redundant 
patches and replacing with 
the same value.

Correction
The Correction tool de-
tects faulty measurements 
or inconsistent measured 
values and replaces the 
data with expected mea-
surement values. 

Smoothing
Corrects inhomogeneous 
measurement data and 
non-smooth curves by 
interpolating existing 
smoothed data. The Auto 
correction uses the maxi-
mum slider setting.

White Correction
Apply manual corrections 
to whitest color patch, 
typically the paper or 
other substrate. The White 
Correction tool is designed to be 
used only on a single measurement 
file.

Brightener
Step one: Analysis

The brightener correction analyzes 

of the remission curve of the paper 
white to ascertain whether the 
paper contains optical brighteners or 
blue-colored paper. 
Step two: Correction

Correction will be applied if optical 
brightener has been detected. The 
correction can be adjusted via a 

Tone Value Dialog
FIG 5.1

05 EDITING
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slider control and at 100% setting, a 
similar result will be achieved as if the 
paper were measured with a UV cut 
filter.

Tone Value
The Tone Value tool is specifically 
designed to correct measurement 
data to a specific set of curves. Data 
will be corrected with a "what if " the 
data was printed to (e.g. G7) specific 
conditions. 
ColorAnt’s Tone value tool can opti-
mize measurement data according to 
either a desired tone value increase 
property or gray balance property. 
Three 
options and 
methods are 
available:
Correct ac-
cording to a 
given profile

Specify a 
profile and 
the mea-
sured values 
are adjusted to achieve exactly the 
same tone value increase curves as 
those achieved with the standard 
profile that was specified.
Correction according to G7 Gray 
Balance

Tone value curves are calculated to 
match the gray balance requirements 
of the G7 calibration process.
Correction according to TVI 
targets

Manual editing of each channel (Fig 
5.1) allows the user to predefine the 

tone value increases that should be 
incorporated in the measurement 
data.

Rescale
ColorAnt can calculate large test 
charts (Fig 5.2) that can be used 
for profiling from small test chart 
measurement files. Some printing 
processes, (e.g. flexo printing on 
uneven materials) pose challenges 
to an artifact-free printing ECI2002 
test chart. The an effective approach 
to measuring large charts would be 
to  place several small test charts, 
e.g. ColorLogic Reprofiler strips on 
one page, measuring the test strips 

and, averag-
ing them in 
ColorAnt and 
then scaling 
up to a large 
ECI2002 test 
chart with the 
Rescale tool.

Averaging
Average several measurement files of 
the same test chart.

Link
Average multiple test charts into one 
large measurement file. This tool 
should be used in conjunction with 
the Redundancies tool.

ICC Transformation
Use both ICC device and DeviceLink 
profiles on reference data (device 

Rescaling a chart to an IT8.7-4
FIG 5.2

EDITING
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data like CMYK or RGB) to test the 
impact of an ICC color conversion 
with up to three profiles.

CIE Conversion
Change the standard observer, illumi-
nation from standard D50.

Edit Primaries
The Edit Primaries tool (Fig 5.3) 
allows users to add, remove, and 
exchange primaries or the paper/
substrate in an existing measured 
test chart. In typical 
print production, 
adding or swapping 
ink(s) requires the 
expense of printing a 
complete test chart. 
The Edit Primaries 
tool simply requires 
the spectral data of 
the new ink(s) to be 
added or exchanged. 
Edit Primaries will not 
only exchange the inks 
but also recalculate 
all overprints based 
on intelligent spectral 
color models. One of 
the major features of 
the Edit Primary tool 
is the ability to dynamically choose 
the best patches from the data pro-
vided. The more complete the data 
that is provided to the Edit Primaries 
tool (spectral data is preferred) the 
more accurate the results. Items that 
will improve are: the exchange are 
gradations of the primary color, over-
print information, such as the primary 
combined with black.

Scenarios for potential efficiency 
gain with the Edit Primaries tool in 
production :
Variance in press condition: The 
characterization press run is slightly 
deficient in solid ink density or hue 
on one or more colors.
Exchange of paper/substrate: The 
inks are the same but a slightly differ-
ent paper shall be used.
Exchanging inks in a packaging 

print production environment: 

Create a new profile that swaps in 
e.g. Blue for a Cyan or a Rhodamine 
Red for Magenta.
Flexibility for the packaging 
manufacturer: Create different 
color variants from a full blown 7 
color press characterization data set 
by deleting channels to building new 
characterization data sets without 

Edit Primaries Dialog
FIG 5.3

EDITING TOOLS
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printing a new test chart. For exam-
ple, from an original 7C data set (e.g. 
CMYK+Orange+Green+Violet) build 
variants for CMYK only, CMY+Violet, 
CMYK+Orange+Green or other 
combinations. The production facility 
would need to ensure the press is 
stable and depending on the color 
needs of the job(s), and print select 

the profile with the least amount of 
channels. 
Increasing CMYK gamut: Adding 
a 5th, 6th or 7th color to the CMYK 
printing process. 

Using Edit Primaries
ColorLogic's suggested workflow: 
Load another data set with the 
measured new primaries, gradations 
of the primaries and overprint 
information.
Select the measurement data of 
a test chart measurement file for 

editing and click Edit Primary.

Exchanging a primary: Click on 
the eyedropper icon of the color 
to be exchanged. Select the new 

EDITING TOOLS

Exchanging cyan ink using Edit Primaries
FIG 5.4
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primary from another data set loaded 
in ColorAnt. Click on the channel 
to be imported to the primary. The 
screenshot shown (Fig 5.4) with a 
new Cyan ink that is slightly different. 
Selecting ink from other channels is 
also possible. 
Click OK and the data set will be 
modified.
Important: Using 
Lab values will 
not produce the 
highest quality re-
sults. ColorLogic 
recommends us-
ing spectral data. 
When a data set 
is present, enter a 
new Lab value for 
the selected color 
or select another 
channel from the 
same measure-
ment data set 
to change the 
printing order.
To check the 
exchange of 
primaries, use the 
Compare tool to 
verify the data.

Exchange of paper/
substrate
Load the test chart measurement data 
and load the secondary file containing 
information of the measured paper 
white into ColorAnt.
Select the measurement data of a 
test chart for editing and click Edit 
Primaries.

Click on the eyedropper icon of the 
Substrate/White and select the new 
paper white from an other data set 
loaded in ColorAnt (Fig 5.5) Click on 
the name of the data set to import the 
data. The second option is to manually 
enter the new Lab values in the text 
field.
Click OK and the data set will be 
modified.

Adding channels
Load the test chart measurement data 
and load the secondary information 
with the measured primaries, grada-
tion and overprint information into 
ColorAnt.
Select the measurement data of a 
test chart for editing and click Edit 
Primaries.

EDITING TOOLS

Exchanging paper white using Edit Primaries
FIG 5.5
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Quick Start Procedure
Step one: Click on Add Channel. A 
new channel with some default gray 
Lab values and the channel name 
Auto is added.
Step two: Click on the eyedropper 
icon of the new channel and select 
the new primary from an other data 
set loaded in ColorAnt. Click on the 
channel to import the data.
The screen-
shot shows an 
example where 
a 5th Orange 
color (Fig 5.6)
has been added 
to an original 
CMYK data set. 
To rename the 
channel click on 
the pencil icon 
and enter the 
new channel 
name.
Step three: 
Click OK to 
generate the 
new data set. 
To view the 
new data set, 
use the View 
tool and select 
the tabs 2D, 
3D, SpiderWeb, TVI to verify that all 
colors including overprints have been 
added Additional edits can be made 
to the curves using the Tone value 
tool.

Removing channels
Load and select the measurement 
data of a test chart and click Edit 
Primary.

Disable the checkboxes in front of 
the channels that need to be deleted 
and click OK.
The new data set will be reduced to 
the channels that were selected. 

EDITING TOOLS

Adding a channel with Edit Primaries
FIG 5.6
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